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ABSTRAK

Karang Taruna merupakan salah satu alternatif pembinaan remaja yang terbaik. Melalui
organisasi ini, anggota Karang Taruna memperoleh lingkungan yang dapat mengembangkan
kreatitivitas. Pengabdian pada masyarakat merupakan salah satu bentuk implementasi dari Tri
Darma Perguruan Tinggi terutama yang peduli dengan kehidupan sosial masyarakat sekitar kampus.
Pelatihan yang diikuti oleh Karang Taruna Garuda Muda Pulo Wonokromo Surabaya nantinya
diharapkan dapat menularkan pengetahuan dan ketrampilan tersebut kepada yang lainnya salah
satunya kegiatan pelatihan membuat atau merancang backdrop kerohanian Islam.

Kata kunci: backdrop, karang taruna, kreativitas, pelatihan
ABSTRACT

Karang Taruna is one of the best alternative for youth development. Through this
organization, members of Karang Taruna get an environment that can develop creativity.
Community service is one form of implementation of the Tri Darma Perguruan Tinggi,
especially those concerned with the social life of the community around the campus. The
training, which was attended by Garuda Youth Youth Organization Pulo Wonokromo
Surabaya, is expected to be able to spread the knowledge and skills to others, one of which
is the training to create or design Islamic spiritual backdrops.

Keywords: backdrop, creativity, training, youth

PENDAHULUAN mereka pada kepribadian yang benar.

Masa remaja adalah saat-saat Gaya hidup dapat pula mewujud
pembentukan pribadi, dimana dengan menembus berbagai
lingkungan sangat berperan. Kalau kelompok sosial, sehingga
kita perhatikan ada empat faktor menjadikan gaya hidup sebagai
lingkungan yang mempengaruhi perangkat buat mengenali suatu
remaja, yaitu lingkungan keluarga, kelompok, bisa menjerumuskan
sekolah, teman pergaulan dan dunia (Ibrahim, 1997 : 206). Pembinaan
luar. Lingkungan yang dibutuhkan remaja dalam Karang Taruna
oleh remaja adalah lingkungan yang bertujuan agar remaja tersebut
mendukung perkembangan imaji menjadi anak yang baik, beriman,
mereka secara positif dan menuntun berilmu, berketerampilan, mandiri
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dan bertanggung jawab. Untuk
membina remaja bisa dilakukan
dengan berbagai cara dan sarana,
salah satunya melalui Karang Taruna.
Yaitu suatu organisasi atau wadah
perkumpulan  remaja  kampung
sebagai penggerak aktivitas atau
kegiatan di daerahnya. Karang
Taruna merupakan salah  satu
alternatif pembinaan remaja yang
terbaik. Melalui organisasi ini,
anggota Karang Taruna memperoleh
lingkungan yang Islami serta dapat
mengembangkan Kkreatitivitas.

Karang Taruna membina para
anggotanya agar beriman, berilmu,
memiliki keterampilan, mandiri dan
bertanggung  jawab.  Pembinaan
dilakukan dengan menyusun aneka
program yang selanjutnya
ditindaklanjuti  dengan  berbagai
aktivitas. Karang Taruna yang telah
mapan biasanya mampu bekerja
secara terstruktur dan terencana.
Mereka menyusun Program Kerja
periodik dan melakukan berbagai
aktivitas. Hal itu dilakukan dengan
melakukan proses kaderisasi yang
dilakukan secara serius, sistimatis dan
berkelanjutan, melalui jalur:
pelatihaan, kepengurusan, kepanitia-
an dan aktivitas. Dalam proses
kaderisasi dilakukan upaya-upaya
penanaman  nilai-nilai,  akhlaq,
intelektualitas, profesionalisme,
moralitas dan integritas Islam.
Sehingga diperoleh kader ideal
Karang Taruna yang memiliki profil:
remaja  beriman, mandiri dan
bertanggung jawab.
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Karang Taruna (Kartar) yang
akan diberikan pelatihan ini bernama
Karang Taruna Garuda Muda. Karang
Taruna ini terbilang baru karena baru
berdiri pada tanggal 13 November
2016. Karang Taruna ini berada di
Pulo Wonokromo RW.05 Surabaya.
Adapun program kerja karang taruna
jangka pendek berupa pendaftaran
usia SMP-SMA (usia 12-18 tahun)
selesai sekolah  sebelum Kerja,
silaturahmi awal, pengisian biodata,
hobby, bakat, mengadakan kegiatan
sesuai minat bakat dan bekerja sama.
Sedangkan kegiatan jangka
menengah, yaitu: pemilihan ketua
karang taruna dan pengurus inti.
Sejak berdiri hingga sekarang Karang
Taruna  Garuda  Muda telah
mengadakan tiga kegiatan besar
diantaranya pada bulan November
2016 mengadakan Jalan Sehat tingkat
RW, bualn  Desember 2016
mengadakan pelantikan anggota
Karang Taruna Garuda Muda serta
Latihan Dasar Kepemimpinan di
Pandaan Jawa Timur, sedangkan pada
bulan Januari 2017 telah mengadakan
KBK (Kerja Bakti Kampung) di Pulo
Wonokromo Surabaya. Kegiatan
jangka pendek Karang Taruna berupa
penyelenggaraan  kegiatan  sesuai
minat dan bakat, maka Tim PKM

Jurusan Desain  FBS UNESA
bermaksud mengadakan kegiatan
berupa pelatihan pembuatan

backdrop (desain latar panggung)
bagi Karang Taruna Garuda Muda di
RW.05 Pulo Wonokromo Surabaya.
Selain  menampung permintaaan
Karang Taruna Garuda Muda. Selama
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ini desain backdrop yang dibuat
masih dikerjakan secara manual.
Untuk itu dalam rangka efektifitas
serta  efisiensi kerja maka
diperlukanlah pelatihan pembuatan
desain backdrop ini. Selain itu
nantinya juga diharapkan menjadi
bibit bidang kewirausahaan bagi
Karang  Taruna tersebut agar
dikemudian hari Karang Taruna
Garuda Muda di RW.05 Pulo
Wonokromo Surabaya tidak hanya
mengandalkan anggaran dari RT
ataupun RW tetapi mereka juga
mampu berproduksi sendiri.

Target dan Luaran

Pengabdian pada masyarakat
merupakan salah  satu  bentuk
implementasi dari  Tri  Darma
Perguruan Tinggi terutama yang
peduli dengan kehidupan sosial
masyarakat sekitar kampus. Untuk itu
jurusan Desain yang memiliki tim
PKM akan mengimplementasikan
ilmu yang terkait kepada Karang

Taruna Garuda Muda di Pulo
Wonokromo Surabaya.
Sasaran dan kegiatan

pelatihan ini adalah Karang Taruna
Garuda Muda di Pulo Wonokromo
Surabaya. Dengan adanya beberapa
keterbatasan maka pelatihan hanya
diikuti oleh 15 sampai 20 anggota
Karang Taruna Garuda Muda di Pulo
Wonokromo Surabaya. Diharapkan
pelatihan ini nantinya menularkan
pengetahuan dan ketrampilan tersebut
kepada yang lainnya serta mendorong
kreativitas dan juga kewirausahaan
bagi Karang Taruna Garuda Muda di
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Pulo Wonokromo Surabaya tersebut
agar di kemudian hari karang taruna

Pulo Wonokromo tidak hanya
mengandalkan anggaran dari kas saja
tetapi  mereka  juga  mampu

berproduksi sendiri. Keterkaitan yang

bisa dijalin dalam kegiatan ini antara

lain.

1. Mempererat hubungan antara
warga kampus dengan Karang
Taruna Garuda Muda di Pulo
Wonokromo Surabaya. Jika hal
ini terjalin dengan baik, maka
kedua belah pihak merasa saling
membutuhkan.

2. Kegiatan pelatihan pembuatan
backdrop kerohanian Islam bagi
Karang Taruna Garuda Muda di
Pulo Wonokromo Surabaya ini
dilakukan agar dapat lebih
meningkatkan hubungan baik
yang selama ini telah terjalin,
sekaligus dapat meningkatkan
kualitas ketrampilan dan
kreatifitas bagi Karang Taruna
Garuda Muda sehingga nantinya
diharapkan mereka juga dapat
meningkatkan penghasilan bagi
organisasi tersebut.

Luaran yang akan dihasilkan
setelah kegiatan ini dilaksanakan
adalah.

1. Hand out, berupa pengetahuan,
bahan, alat, dan langkah-langkah
pembuatan backdrop.

2. Hasil  perancangan
backdrop.

3. Artikel limiah.

berupa

113



Hendro Aryanto’, M. Rois Abidin?/Aksiol

giya: Jurnal P

METODE PELAKSANAAN

Kegiatan ini  diharapkan
mampu  menjadi  bibit  bidang
kewirausahaan bagi Karang Taruna
Garuda Muda di Pulo Wonokromo
Surabaya. Peserta nantinya
diharapkan mampu untuk merancang
desain sendiri melalui software Adobe
Photoshop mauapun software Corel
Draw yang peserta kuasai. Melihat
permasalahan yang dihadapi oleh
Karang Taruna Garuda Muda di Pulo
Wonokromo  Surabaya, = metode
pendekatan yang ditawarkan untuk
mendukung realisasi program ini
dimulai dengan melakukan
pendekatan terlebih dahulu dengan
mitra untuk mengetahui secara
langsung permasalahan yang
dihadapi oleh mereka. Tim pelaksana
mengkoordinasikan ke dalam tim,
kemudian solusi yang ditawarkan
kepada mitra.

Studi Kelayakan

Berupa studi pendahuluan
yang dilakukan oleh tim pelaksana
untuk  mengetahui  lebih  jauh
mengenai kelayakan mitra mengikuti
kegiatan yang ditawarkan oleh tim,
dilihat dari permasalahan yang
dihadapi hingga sumber daya
manusia yang dimiliki oleh mitra.
Tahap ini dilakukan dengan teknik
wawancara serta berdiskusi dengan
beberapa pengurus Karang Taruna
Garuda Muda di Pulo Wonokromo
Surabaya.  Wawancara  tersebut
kemudian dilanjutkan dengan
observasi langsung ke lokasi untuk
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mengetahui secara nyata kondisi
geografis dan demografis.
Berikutnya tim pelaksana

melakukan  koordinasi dengan
memberikan pengetahuan/
pemahaman  dasar-dasar tentang
pembuatan/perancangan  backdrop,

menerapkan pengetahuan yang sudah

diberikan dengan  melaksanakan
praktek perancangan pembuatan
backdrop, mengevaluasi hasil

kegiatan melalui observasi, evaluasi
karya, serta angket untuk mengetahui
tanggapan peserta pelatihan.

Pelaksanaan Kegiatan

Diawali  dengan  proses
perijinan baik tempat maupun sarana
dengan instansi terkait dalam hal ini
adalah pihak Karang Taruna Garuda
Muda di Pulo Wonokromo Surabaya
untuk memastikan waktu dan tempat
pelaksanaan agar tidak berbenturan
dengan kegiatan yang lainnya.
Setelah waktu ditentukan maka
dengan pasti meminta ijin dari pihak
RT, RW maupun kelurahan sudah
disetujui.

Setelah mempersiapkan
segala sesuatunya, tim pelaksana
melaksanakan pelatihan dan
monitoring serta evaluasi yang
dilakukan oleh tim PKM itu sendiri.
Pelaksanaan kegiatan Pengabdian
bagi masyarakat ini dibagi menjadi
dua tahap yaitu.

Pembinaan Ketrampilan

Pembinaan ketrampilan
melalui pelatihan pembuatan
backdrop kerohanian Islam secara
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sederhana, dapat sebagai alat yang
memiliki fungsi untuk
menyampaikan pesan. Media
merupakan sarana komunikasi berupa
ruang dan waktu untuk
menyampaikan pesan baik
pemasangan iklan dalam bentuk cetak
maupun audiovisual kepada khalayak
sasaran yang dituju (Kasali, 2002:31).
Pelatihan ini diberikan kepada
Karang Taruna Garuda Muda di Pulo
Wonokromo Surabaya. Tim
pelaksana  mengusulkan  kepada
Karang Taruna Garuda Muda agar
pembinaan pengembangan ekonomi
kreatif melalui pembuatan backdrop
dengan kegiatan workshop.

Saat ini didunia praktisi yang
serba teknikal, keahlian layout, paste-
up, dan montase film kini sudah
digantikan semuanya dengan digital
komputer (Wibowo, 2009:183). Hal
tersebut jelas akan mempermudah
dan mempercepat proses mendesain
dengan metode yang diterapkan yaitu:

1. Presentasi
Berupa penjelasan materi kepada
peserta  pelatihan  mengenai
langkah-langkah pembuatan/
perancangan backdrop dengan
menggunakan software Adobe
Photoshop dan Corel Draw,

mulai dari penentuan ukuran
bidang desain, pengambilan
gambar/foto  sampai  proses
melayoutnya.
2. Demonstrasi

Memberikan  contoh  teknik
pembuatan backdrop dan
memperagakan langsung

giya: Jurnal P
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langkah-langkah perancangan

backdrop di hadapan peserta
pelatihan.

3. Latihan Praktek
Menerapkan langsung materi
yang telah didapat melalui
presentasi dan  demonstrasi
dengan latihan menggunakan

LCD vyang telah disiapkan oleh
tim.

Langkah-langkah untuk mela-
ksanakan kegiatan ini adalah sebagai
berikut.

1. Memberikan
pengetahuan/pemahaman dasar

tentang  layout  pembuatan
backdrop.

2. Menerapkan pengetahuan yang
sudah diberikan dengan
melaksanakan praktek
pembuatan backdrop.

3. Mengevaluasi hasil kegiatan
melalui  observasi, evaluasi
karya, serta angket untuk

mengetahui tanggapan khalayak
sasaran terhadap pelatihan yang
dilaksanakan.

Strategi  pelaksanaan  ke-
giatannya adalah sebagai berikut.
1. Tahap Pengenalan
Pengenalan dalam hal ini meliputi
pengenalan diri instruktur dan
pengenalan materi  pelatihan.
Pengenalan tentang layout dan
desain yang bagus untuk
pembuatan backdrop. Pengenalan
dilakukan dengan memberikan
ceramah singkat tentang
bagaimana mendesain sebuah
backdrop yang menarik dan
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komunikatif mulai dari layoutnya,
pemilihan tipografi, pemilihan
gambar/visual sampai
finishingnya. Untuk komputer/

laptop, peserta  diharapkan
membawa sendiri, sedangkan
perangkat lunak menggunakan
Adobe Photoshop dan

CorelDraw. Pada pengenalan ini
juga ditunjukkan contoh hasil
perancangan  backdrop  dari
produk yang sudah ada.

Tahap Pelaksanaan

a. Persiapan, meliputi.

1) Penyiapan peserta.
Peserta dipersiapkan oleh
Karang Taruna Garuda
Muda, jumlah peserta
kurang lebih ada 15 orang.

2) Persiapan tempat.
Tempat  yang akan
digunakan harus
dipersiapkan sedemikian
rupa sehingga pelatihan
dapat dilaksanakan
dengan lancar, baik untuk
pemberian teori maupun

untuk praktek.
Rencananya tempat
pelaksanaan pelatihan

menggunakan balai RW.
05 Pulo Wonokromo
Surabaya.

3) Persiapan bahan dan alat.
Bahan dan alat harus
dipersiapkan sebelumnya
agar  pelatihan  dapat
dilaksanakan tepat waktu.
Pengecekan terhadap
bahan dan alat yang
dibutuhkan harus
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dilakukan sebelum
kegiatan, sehingga apabila
ada  kebutuhan  yang
belum terpenuhi maka
dapat segera diupayakan.

b. Pelaksanaan kegiatan.
Sebelum pelaksanaan
kegiatan pelatihan, tim PKM
Jurusan Desain Unesa
menghubungi  representatif
dari Karang Taruna Garuda
Muda, dalam hal ini adalah
ketuanya. Kemudian diadakan
kesepakatan  setelah itu
kegiatan  pelatihan  akan
dilaksanakan sesuai dengan
jadwal yang telah disepakati
bersama.

c. Evaluasi dan Finishing.
Finishing maksudnya hasil
akhir terhadap produk yang
telah  dihasilkan  peserta
pelatihan, misalnya dengan
memberikan evaluasi dan
apresiasi pada karya backdrop
yang sudah dihasilkan. Untuk
hal ini akan dibuatkan
petunjuk pelaksanaan dan
teknis evaluasi.

3. Tahap Dokumentasi Laporan.

Tahap  dokumentasi  laporan
merupakan tahap terakhir dari
kegiatan pelatihan ini.

Dokumentasi ini dibedakan atas:

a. Dokumentasi yang terkait
dengan modul proses
pembuatan backrop.
Pada tahap ini dilakukan
proses pembuatan modul/
handout yang terkait dengan
materi pelatihan  yakni
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pembuatan desain backdrop
kegiatan kerohanian Islam.

b. Dokumentasi terhadap
laporan  kegiatan  secara
keseluruhan.

c. Pada tahap ini dilakukan
proses  pencatatan/  pen-
dokumentasian proses yang
terjadi  selama  kegiatan
pelatihan ini berlangsung dari
awal hingga akhir. Proses
dokumentasi dilakukan
dengan foto maupun video.

Evaluasi kegiatan

Dalam setiap proses pelatihan
tentu harus disertai dengan
kegiatan evaluasi, karena evaluasi
merupakan salah satu dari
indikator keberhasilan sebuah
kegiatan. Keberhasilan kegiatan
pelatihan  desain backdrop
kerohanian Islam ini dapat dilihat
dari capaian beberapa indikator,
antara lain sebagai berikut:

Tabel 1. Evaluasi Kegiatan

giya: Jurnal P

No

Indikator

Aktifitas Keberhasilan

Persiapan a.
kegiatan

Lancarnya
koordinasi dengan
lembaga terkait
dan Karang Taruna
Garuda Muda
b. Adanya dukungan
positif dari pihak-
pihak peserta
pelatihan yakni
Karang Taruna itu
sendiri maupun
pihak RT, RW,
maupun
Desa/Kelurahan.
c. Tersedianya bahan
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No Aktifitas

Indikator
Keberhasilan

dan alat yang
sesuai kebutuhan
proses pelatihan
pembuatan desain
backdrop.

2 | Pelaksanaan
kegiatan

Partisipasi dan
kehadiran peserta
minimal 75%
selama
pelaksanaan
kegiatan.
Instruktur dapat
berperan aktif dan
maksimal dalam
melakukan
pembimbingan
peserta pelatihan.
Peserta berperan
aktif dalam
mengikuti
pelatihan.
Kegiatan pelatihan
terlaksana sesuai
jadwal yang
direncanakan.
Peserta mampu
membuat desain
backdrop
sebagaimana yang
telah dilatihkan.

3 | Pasca
kegiatan

Ada karya/produk
yang dihasilkan
peserta pelatihan.

. Laporan

pelaksanaan
kegiatan tersusun
sebagaimana
mestinya.

5. Pembinaan manajemen produksi

dan pemasaran
Pembinaan

pembuatan

backdrop sampai dengan manajemen

produksi  dan

pemasaran

akan

dilaksanakan melalui pendampingan.
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Tim memberikan  pendampingan
khalayak sasaran yang dianggap
strategis untuk dilibatkan dalam
kegiatan ini adalah Karang Taruna
Garuda Muda di Pulo Wonokromo
Surabaya dengan usia antara 14 — 50

5

tahun.
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anggota

Taruna Garuda Muda di

Wonokromo Surabaya yang diberi

pelatihan ~ pembuatan

berjumlah 15 orang.

Tabel 2. Identitas peserta pelatihan pembuatan backdrop

backdrop

No Nama Alamat Jenis Kelamin
1 | Risky Nadila D.W Wonokromo Wanita

2 | Anggraini Dwi Wonokromo Wanita

3 | Moch. Sulaiman Wonokromo Laki-Laki

4 | M. Zasal A. Wonokromo Laki-Laki

5 | Ryco Tarnuwardhana P. Wonokromo Laki-Laki

6 | Vanni Diah Wonokromo Wanita

7 | Mario Dani A. Wonokromo Laki-Laki

8 M. Ari Setiawan Wonokromo Laki-Laki

9 | Audy Shafa Salsabila Wonokromo Wanita

10 | Ita Wonokromo Wanita

11 | Kurniyati Wonokromo Wanita

12 | Ika Rafika Sari Wonokromo Wanita

13 | Achmad Galih Purbaya Wonokromo Laki-Laki
14 | Audimatul M. Wonokromo Wanita

15 | Flaroon M. Wonokromo Laki-Laki

Luaran bentuk dari implementasi Tri Darma

Iklan memiliki banyak sekali
kemungkinan fungsi, tergantung pada
isi pesan itu sendiri (Widyatama,
2009:133). Hal ini termasuk luaran
yang dihasilkan oleh Karang Taruna
Garuda Muda di Pulo Wonokromo
Surabaya yaitu berupa desain
backdrop acara kerohanian Islam.

Kelayakan Perguruan Tinggi
Program pengabdian kepada
masyarakat (PKM) yang berada di
bawah naungan Lembaga Penelitian
dan Pengabdian pada Masyarakat
(LPPM) Unesa selalu berusaha untuk
membantu dan meningkatkan mutu
layanan kepada masyarakat sebagai

118

Perguruan Tinggi. Sejak tahun 2014
LPPM Unesa memperbaiki system
pelayanan, manajemen secara online.
Pembentukan bidang garapan,
kerjasama dan pemetaan potensi
daerah  sebagai acuan  untuk
pelaksanaan PKM terus
dikembangkan agar lebih bermanfaat
serta tidak tumpang tindih. Sosialisasi
program,  penyusunan  proposal,
pelaksanaan kegiatan dan evaluasi
selalu diadakan setiap tahunnya.

HASIL YANG DICAPAI

Kegiatan pengabdian kepada
masyarakat ini diawali dengan
penyusunan  handout oleh tim
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pelaksana yang kesemuanya adalah
dosen di Jurusan Desain FBS Unesa.
Handout disesuaikan dengan
kemampuan peserta yang mayoritas
sudah menguasai software Adobe
Photoshop dan Corel Draw untuk
pembuatan backdrop acara
kerohanian Islam. Materi yang
disampaikan nantinya berasal dari
berbagai sumber pustaka baik dari
buku maupun internet. Sumber
pustaka tersebut kemudian
digabungkan menjadi satu kesatuan
handout yang utuh. Di dalam handout
ditampilkan langkah-langkah
membuat backdrop acara kerohanian
Islam

Gambar 1. Suasana pembukaan
pelatihan pembuatan backdrop oleh
ketua Karang Taruna Garuda Muda

Pulo Wonokromo
(Sumber: Dokumentasi Pribadi, Mei 2017)

Latihan  Membuat  Backdrop
Sederhana Acara Kerohanian
Islam

Setelah  kita  mengetahui

fungsi serta karakteristik tools yang
ada di Adobe Photoshop maka pada
pembahasan ini ada 5 langkah
sederhana saja, namun demikian
nantinya bisa dikembangkan sesuai
dengan kreativitas dan juga keinginan
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masing-masing. 5 langkah tersebut

adalah sebagai berikut.

1. Persiapan bidang kerja pada
Adobe Photoshop.

2. Proses cropping dan Cutting
Image/Pemotongan bahan-bahan.

3. Proses Coloring/pewarnaan/

Image Adjustment sekaligus olah
efek digital.
4. Pemilihan  dan
tipografi/huruf.
5. Eksport/save/penyiapan dokumen
siap cetak.

pengolahan

Gambar 2. Pengarahan dari tutor

sebelum kegiatan dimulai
(Sumber: Dokumentasi Pribadi, Mei (2017)

Persiapan Bidang Kerja.

Perhatikan langkah dibawah ini.

1. File -> New (setelah itu akan
muncul kotak dialog)

2. Width dan Height
menjadi  “centimeter”
sesuai keinginan

3. Ubah Resolution menjadi 200
pixel.

4. Color Mode warna bisa dipilih
RGB saja, jika diprint besar pilih
CMYK.

5. Kiik OK.

diubah

dan 1si
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Gambar 3 Peserta pelatihan

mempelajari modul
(Sumber: Dokumentasi Pribadi, Mei 2017)

merancang backdrop
(Sumber: Dokumentasi Pribadi, Mei 2017)

Cropping dan Cutting Image/

Pemotongan bahan

1. Buka gambar/image yang telah
dipersiapkan, dengan mengklik
File -> Open.

2. Klik Move Tool (tekan tombol V),
lalu seret gambar ke bidang kerja.

3. Lakukan berulang pada semua
gambar yang diperlukan.

4. Untuk mengubah ukuran, Klik
bersamaan Ctrl+T. Tekan Shift,
lalu drag/geser pada posisi yang
diinginkan/besarkan/kecilkan
gambar.
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Potong gambar. Sebelum
memotong, klik 2x tanda gembok
di layer, lalu OK.

Potong dengan menggunakan Pen
Tool (tekan tombol P). Klik pada
gambar mengikuti area yang ingin
dipotong sampai garis
tersambung.

Klik kanan -> Make Selection,
Feather Radius isikan = 1 pixels
Arahkan kursor pada Move Tool
dan klik-tahan pada gambar lalu
seret ke bidang kerja. Untuk
mengubah ukuran lalukan
langkah ke-4.

Coloring/pewarnaan dan olah efek
digital

1.

Untuk membenahi gambar yang
telah dipotong bisa melalui
langkah sebagai ini. Pertama klik
layer gambar, klik Image ->
Adjustment -> Silahkan pilih
(Brightness, Hue Saturation,
Curve dll, sesuaikan dengan
kebutuhan).
Jika ada bagian tertentu yang
ingin dihapus bisa memakai
Eraser Tool (tekan tombol E),
pastikan tombol Caps Lock mati.
Untuk  memperbesar  ukuran
penghapus bisa menekan tombol
{dan}.
Jika ingin menambahkan warna
lain sebagai background pada
bidang kerja dengan cara tekan
bersama-sama Shift + Ctrl + N
Setelah terbentuk layer baru, bisa
memberikan ~ warna  dengan
langkah sbb:
a. Kilik Eyedropper Tool (tekan
tombol 1), arahkan ke kotak



Hendro Aryanto', M. Rois Abidin?/Aksiologiya: Jurnal P

warna, klik dan pilihlah
warna.

b. Klik Paint Bucket Tool (tekan
tombol G), arahkan pada
bidang kerja, tuangkan warna
dengan sekali klik.

c. Jika ingin mensapukan warna,
klik Brush Tool (tekan
tombol B), klik-tahan-geser
pada area yang diinginkan.

d. Untuk  membuat warna

gradasi, buat layer baru
(Shift+Ctrl+N). Klik kanan
Paint Bucket Tool, nanti akan
keluar ~ Gradient  Tool,
pilihlah. Setelah itu Kklik-
tahan-geser kea rah yang
diinginkan.

Gambar 5. Tahap perancangan
(Sumber: Dokumentasi Pribadi, Mei 2017)

v!

Gambar 6. Tahap pewarnaan dan

olah digital
(Sumber: Dokumentasi Pribadi, Mei 2017)
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Pemilihan dan

tipografi/huruf.

1. Klik Horizontal Type Tool (tekan
tombol T), klik pada bidang kerja.
Mulailah menulis.

2. Untuk menggeser tulisan pada
tempat yang diinginkan, klik
Move Tool (tekan tombol V),
arahkan pada tulisan/layer tulisan,
geserlah sesuai keinginan.

3. Untuk memberikan efek timbul,
bayangan, garis pinggir dll, klik
2x pada layer tulisan. Kemudian
akan muncul kotak dialog Layer
Style — Blending Option

4. Melalui kotak dialog tersebut kita
bisa mengekspresikan seluruh
gaya desain yang kita inginkan.
Cobalah

pengolahan

e

Gambar 7. Penyempurnaan desain

oleh tutorial
(Sumber: Dokumentasi Pribadi, Mei 2017)

Gambar 8. Suasana tutorial
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(Sumber: Dokumentasi Pribadi, Mei 2017)

Eksport/save/penyiapan dokumen

siap cetak.

1. Begitu pekerjaan selesai, klik File
-> Save -> Namakan file sesuai
keingian.

2. Untuk mempersiapkan file cetak,
klik File -> Save As -> Namakan
File, pilih format .JPEG. Klik
save.

3. File siap dicetak.

Kegiatan pengabdian kepada
masyarakat ini diawali dengan
penyusunan handout oleh tim
pelaksana. Handout disesuaikan
dengan kemampuan peserta yang
mayoritas sudah menguasai software
Adobe Photoshop dan Corel Draw
untuk pembuatan backdrop acara
kerohanian Islam. Materi yang
disampaikan nantinya berasal dari
berbagai sumber pustaka baik dari
buku maupun internet. Sumber
pustaka tersebut kemudian
digabungkan menjadi satu kesatuan
handout yang utuh. Di dalam handout
ditampilkan langkah-langkah
membuat backdrop acara kerohanian
Islam

Hasil karya Pelatihan
Pembuatan  Backdrop  Kegiatan
Kerohanian Islam Karang Taruna
Garuda Muda Wonokromo Surabaya
diharapkan nantinya dapat diterapkan
pada acara lainnya. Siang sampai sore
pada pertemuan pertama para peserta
pelatihan sangat antusias untuk
mencoba. Beberapa contoh backdrop
hasil pengabdian kepada masyarakat
Karang Taruna Garuda Muda
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Wonokromo  Surabaya  sebagai
berikut.

. carn N
._ - -
T ...

1 L} -
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7 -§5o|at Gé’@f’é Mata 'iri
) Bersama -

TAHLIL AKBAR
HAUL KANJENG
SUNAN AMPEL

’ nﬁ
‘}J,.éagtu 13 Mei 2017
MRS 6Tsyaban 1438 H
Y Pukul 15.30 WIB

Bin Yahya Di Magbarah Mbah Kanjeng
Sunan Ampel Surabaya
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Gambar 9 Contoh produk luaran Pengabdian Masyarakat pelatihan Karang Taruna

Garuda Muda di Pulo Wonokromo Surabaya
(Sumber: Dokumentasi Pribadi, Mei 2017)

SIMPULAN
Kesimpulan  yang  dapat
disampaikan oleh tim pelaksanaan

PKM jurusan Desain Fakultas Bahasa

dan Seni UNESA adalah sebagali

berikut.

Pemberian bekal kepada remaja

Karang Taruna Garuda Muda

Wonokromo Surabaya

a. Pelaksanaan Pelatihan Pembuatan
Backdrop Kegiatan Kerohanian
Islam Karang Taruna Garuda
Muda Wonokromo Surabaya
adalah mulai dari pengenalan/
persiapan  bahan dan alat,
memperagakan cara pengolahan/
pencampuran  bahan, sampai
dengan proses cetak yang sudah
disiapkan oleh tim PKM.

b. Pelaksanaan Pembuatan
Backdrop Kegiatan Kerohanian
Islam Karang Taruna Garuda
Muda Wonokromo Surabaya
dilaksanakan pada tanggal 14 Mei
2017 yang dimulai pukul 09.00
WIB dan berakhir pada pukul
17.00 WIB.

c. Dari hasil angket  yang
disebarkan oleh tim PKM kepada
peserta pelatihan dapat
disimpulkan bahwa pelatihan ini
sangat bermanfaat dan menambah
pengetahuan baru bagi Karang
Taruna Garuda Muda
Wonokromo tentang pembuatan
Pembuatan Backdrop Kegiatan
Kerohanian Islam.

Jenis-jenis produk yang dihasilkan

Salah satu produk yang
dihasilkan oleh remaja Karang
Taruna Garuda Muda Wonokromo
Surabaya adalah berupa desain
backdrop.
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